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Course Description

QAD designed this course to cover the basics of using the QAD .NET User Interface (.NET UI) 
with both QAD Enterprise Applications Standard Edition (SE) and Enterprise Edition (EE).

The course includes:

• An introduction to the QAD .NET UI

• Navigating the QAD .NET UI

• Application help options

• QAD .NET UI programs

• Basics of browses

• An introduction to the character user interface

Students will also learn by labs designed to reinforce concepts presented in this training guide.

Objective

Learn how to navigate QAD Enterprise Applications using the QAD .NET UI. In addition, 
students will be able understand the help options, different types of programs, and be able to use 
browses effectively.

Benefits

Students will become more efficient in the use of QAD Enterprise Applications.

Audience

• Implementation consultants

• Members of implementation teams

• Key users

Prerequisites

Students should have some familiarity with Enterprise (EE) and Standard (SE) editions of QAD 
Enterprise Applications.

Course Credit and Scheduling

This course is designed to be taught in two days.
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Virtual Environment Information 

This guide applies to both the Standard Edition and the Enterprise Edition of QAD Enterprise 
Applications. Use the hands-on exercises in this book with the latest Enterprise Edition learning 
environment in the 10USA > 10USACO workspace. When prompted to log in, specify demo for 
user ID and qad for password. 

Note   Users of Standard Edition should complete the exercises in the EE environment; the 
concepts are the same in both environments and can be applied to Standard Edition. Features that 
only apply to Enterprise Edition are noted in the text.

Additional Resources

If you encounter questions on QAD software that are not addressed in this book, several resources 
are available. The QAD corporate Web site provides product and company overviews. From the 
main site, you can access the QAD Learning or Support site and the QAD Document Library. 
Access to some portions of these sites depends on having a registered account.

http://www.qad.com/

QAD Learning Center

To view available training courses, locations, and materials, use the QAD Learning Center. Choose 
Education under the Services tab to access this resource. In the Learning Center, you can reserve a 
learning environment if you want to perform self-study and follow a training guide on your own.

QAD Document Library

To access release notes, user guides, training guides, and installation and conversion guides by 
product and release, visit the QAD Document Library. Choose Document Library under the 
Support tab. In the QAD Document Library, you can view HTML pages online, print specific 
pages, or download a PDF of an entire book. 

To find a resource, you can use the navigation tree on the left or use a powerful cross-document 
search, which finds all documents with your search terms and lets you refine the search by book 
type, product suite or module, and date published.

QAD Support

Support also offers an array of tools depending on your company’s maintenance agreement with 
QAD. These include the Knowledgebase and QAD Forums, where you can post questions and 
search for topics of interest. To access these, choose Visit Online Support Center under the Support 
tab. 
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Chapter 1

Introduction to QAD .NET UI
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Objective
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Benefits
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Training Flow
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Introduction — QAD .NET UI
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Character UI

Unlike the QAD .NET user interface, the character user interface depends completely on input 
from the keyboard. Because it is not a graphical user interface, all navigation is based on:

• A command-prompt interface to execute programs

• Combinations of keystrokes to issue commands within programs

• Navigation without use of a mouse through the UNIX character interface.

Component-based functions are accessible only through the QAD .NET UI. You cannot access any 
of these functions from the character UI. Chapter 6, “Using the Character UI,” on page 115 
discusses this UI in more detail.
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Terminal Mode in the QAD .NET UI

With the QAD .NET UI interface, you can still use non-component based programs in a CHUI 
interface. You do this by selecting Terminal mode in the Program Properties option. This is 
described in Chapter 2 in the topic “Properties Options: Open With” on page 30.
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Attributes of Component-Based Programs
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Component-Based QAD .NET UI Screen

You use traditional mouse clicks, tabs, and keyboard tabbing to navigate the component-based 
screen. 
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Attributes of Non-Component Based Screens

Non-component based screens are based on traditional procedural-written Progress-based 
technology. 
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Non-Component Based QAD .NET UI Screen

All Standard Edition are non-component based. All Enterprise Edition programs except QAD 
Enterprise Financials and some related system administration functions are also non-component 
based.
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Login Menu

Starting the QAD .NET UI

To launch the client, select the QAD Applications icon or menu item under Programs on the Start 
menu. Enter your assigned user ID and password. Select a system environment for which you have 
permissions from the drop-down menu.
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Summary

Exercise and Knowledge Check

1 You can use the mouse for certain functions in Terminal mode. (T/F)

2 Some component-based functions are configurable in Terminal mode. (T/F)

3 Which of the two interfaces depends completely on input from the keyboard?

4 Which Enterprise Edition application is component based?
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Chapter 2

Navigating the QAD .NET UI
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Objective
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Benefits
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Training Flow
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Overview of UI Navigation Features

The QAD .NET User Interface (UI) provides a common framework for multiple QAD 
applications. This framework, based on Microsoft .NET technology, has excellent performance 
and provides best-practice usability and deployment features, as well as extensive ways for users 
to adapt the UI to their preferred work style. 

When you first log into the .NET UI, you see a screen like the one above.

1 The main menu bar includes selections for File, Edit, Tools, Workspace, Window, and Help.

2 The menu search helps you locate programs to run.

3 The Application area displays the application programs that can be run in the QAD .NET UI.

4 Use the dashed bar to close and open the navigation pane. Closing the pane gives you more 
area to work in.

5 The Favorites area can be customized by each user to list frequently used programs.

6 The Quick Search area lets you search for a value across all of the fields in a browse group, 
which are definable by each user (see “Quick Search” on page 103 for details).

7 The Messages inbox displays messages generated through the QAD Enterprise Applications 
internal mail system.

Each distinct area of the UI can be resized to suit your needs by dragging the edge to the place you 
want. 
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Workspace

In the .NET UI, your application context is determined by a combination of domain and entity, 
called a workspace. Workspaces represent the area of your business where you are working. In this 
class, you are using the 10USA > 10USACO workspace, which represents the 10USA domain and 
the 10USACO entity.

Most users only use one workspace and once selected, it is always active by default. When you 
exit the QAD NET UI, the active workspace is saved and displays when you log in again. 

If needed—and you have the necessary access—you can select a different workspace that displays 
on the Workspace menu. The check mark signifies the domain that is currently active. 

If you need to change workspaces regularly, you can also enable the workspace toolbar, shown 
above. Clicking a workspace name in the toolbar changes the current domain and entity. The 
toolbar is enabled using the Show Workspace Selector option on the Tools|Options menu. 

For information on the domain and entity concepts, see Training Guide: QAD Quick Start. 
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UI Navigation: Process Maps

The .NET UI provides many ways to navigate and find programs you are interested in. You can 
select programs from the menu on the left or enter a program name or number the search field. 
These methods are shown in following slides.

This slide shows a top-level view of the process maps supplied with the .NET UI. These maps are 
graphic representations of workflows that can include links to programs, browses, documentation, 
URLs, or other maps. 

The .NET UI includes a Process Editor so that administrators can create their own maps that 
accommodate unique company standards. Users can edit process maps for any segment of the 
organization, or model unique environments in as much detail as appropriate. 

The set of process maps supplied with the product has been carefully designed to incorporate best 
practice workflows tailored for various vertical industries.

Using process maps can:

• Improve end user performance by making process instructions visual and readily available, 
increasing awareness of standard procedures for routine and special tasks. 

• Reduce errors and waste since users quickly access information regarding handling 
procedures, detailed documentation and instructions, eliminating guesswork. 

• Increase global staff communication through maps that are globally available and editable to 
match regional language and operational demands. 
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Drill-Down and Breadcrumbs

Processes are built with two basic components:

• Nodes are represented by various shapes and typically indicate a step within the process.

• Connectors are lines with arrows that indicate the direction of execution for the steps (nodes) 
within the process.

You navigate the process map using nodes, and can retrace your steps using the hyperlinked 
breadcrumbs at the top of the screen.
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UI Navigation: Applications Area

The Applications area displays the menu items for the QAD applications running in the 
QAD .NET UI. When the system is installed, the default menu organization is automatically 
loaded. Multiple screens can be open at any one time. 

You can use the mouse to select menu items. You can use the menu search to:

• Find programs based on one or more menu label keywords, program name, or menu number. 
For example, enter sales to display all menu labels that include the word sales.

• Execute a specific program based on full menu label, program name, or menu number. For 
example, enter Item Master Maintenance, ppptmt.p, or 1.4.1 and then press Enter to display 
Item Master Maintenance. 

• Execute a specific program based on a shortcut defined in the Name field of Menu System 
Maintenance (36.4.4.1 in EE, 36.4.4 in SE).

When typing in the menu search area, different screens appear as the typing continues until the 
proper screen is located. This is called predictive text.
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Menu Properties

You can view the information about a menu item by right-clicking it and choosing Properties from 
the pull-down menu. The Properties window includes two tabs: General and Program.

The other options on the right-click menu let you:

• Find the program in the menu system, so you can see its hierarchical position relative to other 
programs.

Note   The Find in Menu option changes to Collapse Menu when the hierarchy is already 
displayed.

• Add the program to the Favorites area (you can also do this by dragging).

• Open the program in the workspace so you can use it.

• Design a custom version of the program. This option is disabled unless you belong to a special 
group of users with access to the Configurable Screens feature. Configuring custom program 
screens is an administrative function that is covered in Training Guide: QAD .NET UI 
Administration.
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Properties Options

The General tab displays:

URL. The QAD Shell URL for the program.

Key. The program number; 7.1.1 is the program number for Sales Order Maintenance.

Aliases. The program number and name. For example, for Sales Order Maintenance, 7.1.1 is 
the program number and sosomt.p is the program name.

Menu. The menu item folder location.

The Program tab displays:

Domain. The current working domain and domain currency. If the specific program updates 
data that applies to all domains, All Domains displays.

Program. The program name. For example, sosomt.p is the program name for Sales Order 
Maintenance.

UI Template. If the user executing the program has been assigned a Configurable Screens 
version of the program, the name of the assigned UI template displays. The configurable 
screens feature is discussed in Training Guide: .NET UI Administration.

Desktop Version. Version details for the .NET UI.

Version. Product system version details.
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Properties Options: Open With

Open with. Determines how the program will display in the workspace. Possible values are:

Desktop: The mode normally used by non-component programs in the .NET UI, which 
supports all of the enhanced navigation features. 

.NET User Interface: This mode is supported by only a few programs that have been rewritten 
using a client-side plug-in that supports additional navigation features such as drag and drop. 

Browse Viewer: This is the normal mode for browses that displays data in an interactive grid 
or chart format.

Terminal: This mode is a simple representation of a character-based screen.

You can change the Open with property from Desktop or Browse Viewer to Terminal according to 
your preference. If you do so, your choice will be retained from session to session.

Note   You cannot change the Open with setting for component-based programs. 

This slide shows Sales Order Maintenance as it displays in the QAD .NET UI (Desktop mode) and 
the more traditional Terminal version of the screen below. In Desktop mode, you can use point and 
click, tab, Next, Back or Header, Lines, and Trailer Tab to navigate.
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Favorites

The .NET UI lets you customize the interface in many ways to make your work easier. One way to 
do this is to set up your own personal favorites menu. You can do this in two ways:

• Right-click a program in the top list and select Add to Favorites.

• Use your mouse to drag the program to the area below. This makes a copy of the menu item; 
you can still find it in the list above as well.

Remove an item from the favorites using the same steps: either right-click and select Remove or 
drag out of the Favorites. 

You can rename programs in your favorites so they are even more personalized. In addition, you 
can create folders and subfolders for organizing favorites by right-clicking in the Favorites area. 

Two other options let you further manage favorites. You can:

• Select one or more items to start automatically when you log in using the Auto Start option. So 
if, for example, you typically log into the system to approve requisitions, you can have the 
Purchase Requisition Approval program start automatically every time you log in. Items 
selected for Auto Start display in bold text in the menu. 

• You can change the icon associated with a program by loading the image you want to use.

One other useful feature for favorites is that you can add external files by simply dragging and 
dropping them into the favorites area. This slide shows a Microsoft Word file with work 
instructions added as a favorite.
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Workspace Menus

The menus on the menu bar of the .NET UI workspace provide many useful options, discussed 
next. 
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File Menu

The File menu commands include:

Logoff/Login. Log off from all applications running in the QAD NET UI. You can log in as a 
different user if security allows.

Page Setup. Defines print output for browses; this has no impact on maintenance programs.

Print Preview. Generates a print preview of a browse prior to print.

Print. Open the print dialog so that you can print the data for a browse or the screen for other 
programs.

Program History. The section below Print displays the last six programs that you have opened. 
You can choose to open one of these programs directly from this pull-down menu.

Exit. Close the QAD .NET UI and log off any open applications.
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Edit Menu

The Edit menu commands include:

Cut, Copy, and Paste. These are standard Microsoft commands. View associated shortcuts on 
the screen above.

Menu Search. While in any screen you can immediately go to menu search by using the 
shortcut Ctrl+M or select Menu Search from the Edit menu.
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Tools Menu

The Tools menu commands include:

Options. View administrative information and set personal options for browses and other 
application settings. For more information, see next slide. Settings the user cannot configure 
are viewable from Help| View Configuration.

Internet Properties. Update the same settings that display when you select Internet Options 
from the Tools menu in Internet Explorer.

Delete History. Delete the following data:

• Temporary files: Internet Explorer cache and IE cookies and cached resources created for 
the current configuration.

• Session information: the graphical state stored by the GUI persistence manager. Also 
deletes user input, such as last configuration, last workspace, most recently used menu 
items, and credentials. 

Manage Workspaces. Activate and deactivate workspaces from a list and reorder them.
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Tools | Options

QAD .NET UI lets each user configure many different settings that affect the UI in these areas:

Browse. Configure settings for Cancel transaction on drill change, Cell Font, Link Font Color, 
Row Alternating Color, Row Background Color, Rows Per Page, Side Panel Auto Open.

Desktop. Configure settings for Auto advance on next data field, Cell Font, Prompt user on 
open transaction, Screen Navigation Bar, Text Report Font, UI Extensions.

General. Configure settings for Allow Multiple Applications, Left Navigation Panel Style, 
Show Workspace Selector.

Guide Me. Enabled.

Home Page. Enable Home Page, Home Page URL.

Messaging. Configure settings for Auto Complete Recipients Textbox, Display Alerts, Empty 
Deleted Folder Frequency, Poller Frequency.

Metrics. Image, Title.

Terminal. Background Color, Bold Color, Font, Foreground Color.
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Window Menu

This menu displays a history list of programs in the order in which they were opened. Selecting 
Close All Windows shuts all screens on the workspace.
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Help Menu

Use the Help menu to display Application and Program Help, and to view installation and 
application configuration details. Help is discussed in more detail in Chapter 3, “Help in the 
QAD .NET UI,” on page 47.

The Help menu commands include:

Search. This option displays the default search page.

Application Help. This option is available when your cursor is placed within a non-component 
based field or screen. When you then select Application Help, field or procedure help is 
displayed for the field or screen.

View Configuration. Opens a window that displays various configuration settings that cannot 
be directly changed by a user of the QAD .NET UI. These settings must be changed by a 
system administrator.

Send Error Report. Use this option to save or send an error report. You can view the report, 
which includes QAD .NET UI configuration information and log files and enter additional 
information about what you were doing when the problem happened. Optionally, you can 
enter your e-mail address and send a screen shot and either Send or Save.

About. Displays information about the version of QAD .NET UI that is running, the time the 
QAD .NET UI was started, and the total amount of physical memory the QAD .NET UI is 
using. (If N/A is displayed, the operating system is not giving the QAD .NET UI permission to 
access system information.)
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Component and Non-Component Based Programs

Only Enterprise Edition Financials and some System Administration programs are component-
based. All other applications are non-component based, including Standard Edition Financials. 
Component-based programs have individual maintenance programs, such as Create, Modify, and 
Delete.

Chapter 4, “Programs in the QAD .NET UI,” on page 59 provides details about using programs.
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Navigating Component-Based Screens

Because the component-based UI is based on Microsoft .NET technology, it incorporates familiar 
mouse, click and drag, and tabbing functions.
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Horizontal and Vertical Tab Groups

You can choose two ways of viewing multiple screens in the application area. This works 
especially well with the QAD .NET UI browse programs.

This slide shows the Process Sales Order menu collection, which groups all of the programs that 
you might need to use to complete activities related to an order. The grouping is facilitated by 
defining tab groups. Right-clicking the Process Sales Order tab displays the menu in this slide. 

Tab groupings help you organize open programs in either horizontal or vertical layout. 

• Click New Horizontal Tab Group to split the screen horizontally and move this program to the 
new area.

• Click New Vertical Tab Group to split the screen vertically and move this program to the new 
vertical area.

You can only use horizontal or vertical groups, not both. But you can create as many of one type of 
group as you want.

You can also detach a tab from the application area and display it in a new window. Right-click the 
tab and choose Move Tab to New Window or enter Ctrl+F11. To move a tab in a separate window 
back to a tab in the application area, enter Ctrl+F11.
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Navigating Non-Component Based Programs

Because non-component based screens are a rendering of the character UI, you can navigate these 
screens using the same keyboard commands. You can also use mouse clicks to select fields and 
enter data.

When some programs open in Desktop mode, a navigation bar is displayed along the top of the 
screen indicating where you are as you proceed through the program screens. Not all programs 
have this bar; it is typically used with complex transactions such as order creation.

For example, the screen for Sales Order Maintenance includes a navigation bar indicating the parts 
of a sales order: Header, Lines, Trailer. Within each major section, you can navigate using the bar 
to specific subareas. When you are displaying the header of a sales order, you can navigate directly 
to Details, Tax Info, Freight Info, Salesperson, Delivery, Consignment, or Comments by clicking 
the label in the navigation bar.

The Screen Navigation Bar option in the Desktop section of the Options menu (choose Tools|
Options) controls whether your QAD .NET UI client displays the navigation tool.
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Navigating Lookup Browses

Many fields display a small magnifying glass icon on the right of the input area. This indicates that 
a lookup is associated with the field. Click the icon or use the Alt+L keyboard shortcut to display 
the lookup. The lookup lists valid values for the field.

A drop-down list is displayed when only a few values apply to a field.

Browses on the menu, called power browses, include more complex navigation features. Browses 
are discussed in more detail in Chapter 5, “Browses in the QAD .NET UI,” on page 81.
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Summary
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Exercise and Knowledge Check

These exercises and discussion questions will help you become familiar with navigating the user 
interface. 

1 Using each of the Process maps (Vertical Industry, End-to-End, and Supply Chain), drill down 
until you can create a sales order. Which view seemed easiest to you? 

2 Create a custom menu by:

a Right-clicking a menu item and selecting Add to Favorites.

b Drag several menu items into the Favorites section of the UI. 

3 Open the following four programs:

• Sales Order Maintenance

• Sales Order Shipments

• Sales Order Browse

• Sales Order Credit Browse

Right-click on Sales Order Browse and create a new tab group. Add Sales Order Credit 
Browse to the tab group with the other browse. Can you see how this arrangement could help 
you when processing a sales order?

Right-click on Sales Order Browse again and select Close All. 

4 Change the way a program displays:

a Select Customer Data Maintenance from the menu.

b Right-click and select Properties.

c On the General tab, note the menu number associated with this program. What is this field 
labeled? 

d Click the Program tab and change Display with to Terminal. Click OK. 

e Type the menu number (2.1.1) in the search and press Enter.

f Compare the two program displays by selecting a customer record and moving through the 
frames. How is this UI different than the normal Desktop mode? 
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Objective
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Benefits
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Training Flow
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Help in Terminal Mode

Access help in terminal mode by pressing F2.

• The first time you press F2, a lookup browse displays if one is attached. If not, field help 
displays first. Use lookup browses to view records available to specified fields. You can 
choose a record to enter in the field. If you enter a value and press Enter, the list in the bottom 
of the browse frame scrolls to the first record that matches that value. Use the arrow keys to 
scroll through the list, then select the record by pressing Enter.

• Press F2 again to display field help. It describes a specific field and how it is used in the 
program. Most updateable fields have field help. Display-only fields do not.

• Press F2 again to display procedure help. It describes the program and how it is used in the 
module. Procedure help is not generally provided for reports, inquiries, browses, or control 
programs.
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Help Menu

Options on the Help menu include: 

• Search displays a panel where you can search field or program help or both using terms and 
operators.

• Application Help is available when your cursor is in a field. Choosing it displays the relevant 
field or program help. You can display the same information by pressing the F1 key. 

• View Configuration opens a window that displays various configuration settings that cannot 
be directly changed. This information can by useful for system diagnostics. 

• Send Error Report lets you save or send an error report that includes QAD .NET UI 
configuration information and log files. You can enter additional information about what you 
were doing when the problem happened. Optionally, you can enter your e-mail address and 
send a screen shot.

• About displays information about the version of QAD .NET UI that is running, the time the 
session was started, and the total amount of physical memory being used. 
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Application Help (F1) for Programs and Fields

When your cursor is in a program field, you can press F1 or choose Help | Application Help to 
display online help. Help is organized into two tabs:

• The Field Help tab displays a list of fields associated with the current program. Help for the 
field where you cursor is located initially displays in the help panel.

• The other tab displays the name of the program and the associated help information.

At the bottom of the help panel, you can access links to the QAD Document Library or to QAD 
Support, which includes an extensive knowledgebase. 
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QAD Guide Me

The QAD Guide Me feature provides immediate mouse-over descriptions of fields in both 
component and non-component programs. 

Note   If this help does not display, it may be disabled. You can enable it using the Guide Me 
setting found on the Tools|Options menu. 

One useful feature of this help is that you do not need to locate your cursor in a field to see the 
help. In the current example the help for Item Type is being displayed even though the active 
context field is Item Number. 

Click the More... link to display an extended description of the field, and the Edit link to edit this 
description in Field Help Maintenance.

Note   The Edit option displays only if your role gives you access to this program. 
  



Help in the QAD .NET UI 55
QAD Search

Choose Help | Search to display the QAD Search panel. You can do simple searches for single 
terms such as Sales and phrases such as Sales Orders. You can also create more complex terms 
using operators such as Sales AND Region. You can use any of the following operators (entered in 
upper case):

AND, +, OR, NOT, -

If you are unsure of the exact term you are searching for, use wild cards:

• Use a question mark (?) to replace a single character; for example, S?les

• Use an asterisk (*) to replace multiple characters; for example S**es

• Use the tilde symbol (~) to perform fuzzy searches, which return results similar to the term 
you entered. You can specify the similarity to the searched term using a numerical option 
between 0 and 1 for example, sales~0.8. The closer the value to 1, the greater the similarity. 
The default value is 0.5.

• Use numerals to specify words within a specified distance from each other. For example, if 
you enter Sales Region~10, the panel displays all instances of Sales and Region that appear 
within 10 words of each other in a document.
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QAD Document Library

Access the QAD Document Library by clicking the link at the bottom of the application help or 
search panel. The library includes user guides, administration guides, installation guides, training 
guides, and other materials.

You can also access this library directly from your browser: 

http://www.qad.com/documentlibrary

From the Document Library, you can:

• Use the navigation tree on the left, which lists content grouped by QAD application and book 
type. 

• Use the Search, which finds all documents with your search terms and lets you refine the 
search by book type, product suite or module, and date published.
  

http://www.qad.com/documentlibrary
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Summary
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Exercise and Knowledge Check

1 Launch Purchase Order Maintenance in Terminal mode. 

Note   Use Properties, Open with to change the mode to Terminal if needed.

Press F2 in the first field of the purchase order. What is displayed? Press F2 again. What is 
displayed this time? 

2 Go to the Sales Order Maintenance screen and select Help | Search. What screen is displayed? 

3 Do a search on the word Sales. Drill down on Sales analysis. What is displayed?

4 Go to Journal Entry Create and press F1. What is displayed? Note the differences between 
non-component based help and component-based help.

5 Find out the answer to the following question by using one of the forms of online assistance:

When a sales order is created, a default value displays for Credit Terms. Where is this default 
value set?

Which form of help did you use to find the answer? Why?
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Objective
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Benefits
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Training Flow
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.NET UI Program Types

On the menu, a distinct icon indicates the type of program: 

• Maintenance programs

• Transactions and utilities

• Reports and inquiries

• Browses and browse collections

• Menu collections

• Process maps

Each type of program maintains a specific kind of data within the database.

The next slides illustrate the types of programs that you will encounter as you use the product 
during this course. 
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Maintenance Programs

Maintenance programs create and maintain basic codes such as customers, inventory items, GL 
accounts, currencies, and other data. They are also used to record data that initializes business 
activity in a module such as sales orders and purchase orders. Most maintenance programs update 
static data, which is changed infrequently. 

Entering data in a maintenance program creates a record in one or more tables controlled by the 
maintenance program. For example, item records are stored in the Item Master table controlled by 
Item Master Maintenance.

With non-component maintenance programs, all changes to the record are made in the same 
maintenance program. In component-based maintenance programs, changes are made in separate 
Create, Modify, or Delete functions.
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Inquiry and Report Programs

Inquiries and reports retrieve and display database records. 

• Inquiries are primarily used to answer specific questions and are typically viewed online, 
although they can be printed

• Reports usually provide more detail and are printed for a range of data records. You select data 
by entering a specific range of criteria, such as item number or date. Reports are often sent to a 
printer or file. Other output options such as e-mail are available.
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Component-Based Reports

Component-based reports have multiple output options, including viewer, printer, and export to 
PDF, XLS, and DOC standards. The report output is easy to customize, and you can create an 
extensive set of reports with unlimited report variants for many output types. 

You can run a report immediately, or choose to schedule it to run later. In this case, a pop-up 
window opens to let you enter details for running the report at a later date. 
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Transaction Programs

Transactions express the core business activities of a company. They control and record activities 
related to business documents such as sales orders and invoices. Example of transaction are 
shipping a sales order or receipt of a shipment for a purchase order. Enterprise Financials 
transaction programs include Customer and Supplier Invoice Create and Journal Entry.

Most data in the database is transaction data. Every day, sales orders come in, purchase orders go 
out, and work orders make demands on and create material for inventory. These events result in 
transactions, which are stored in transaction tables. In contrast to control programs, transaction 
tables are constantly updated by users of the system.
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Control Programs

When you implement a module, you enter data that the system uses later to control the interactions 
with users and with the database. This data is stored in control tables.

Control tables enable you to adapt QAD Enterprise Applications to your environment. The data 
and settings in these tables determine how certain programs are displayed, the numbers assigned to 
transactions, the GL accounts for particular transactions, and so on. When you can manage a 
typical manufacturing function in more than one way, control settings enable you to establish a 
preference.

This slide shows two control programs with settings that affect work order processing. To support 
the enhanced segregation of duties features of QAD Enterprise Edition, financial control settings 
are updated separately from operational controls. For example, Work Order Control (16.24) under 
the Work Order menu in Manufacturing has only the operational control settings for work orders. 
All of the financial control settings for work orders are in Work Order Accounting Control 
(36.9.11) under the Operational Acct Controls menu in System Administration.

Note   This is unlike QAD Standard Edition, where all control settings for a functional area are 
updated in one program.
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Program Options

The menu options for browses are described in Chapter 5, “Browses in the QAD .NET UI,” on 
page 81. This section describes key menu options on maintenance and transaction programs. 
These options differ somewhat between component-based and non-component based programs. 
Component-based programs have an Actions menu and a Tools menu; non-component based 
programs have only the Actions menu. 

This table summarizes differences in the program menus.

Non-Component Based Component Based

Go To links are added manually using User Tool 
Maintenance (36.4.8.5 in EE, 36.20.4 in SE).

Go To links are supplied automatically by the system based 
on the structure of the program. These include related views 
and other options based on the field currently in focus. For 
example, when GL Account is in focus, you can go directly 
to creating a new budget group.

No Tools menu; Workflow option is on Actions menu. 
Design customizations is accessed directly through 
menu-level programs and right-click menu option.

Tools menu includes Workflow and Design Mode. Users 
with access can modify the user interface appearance of the 
program. 

Simple workflow with link to program. More complex, structured, and predefined workflows. 

Actions menu is mainly simple record-level actions. It 
includes an Export action that creates an XML file. 

Actions menu is more complex and changes based on 
specific program context. You can save and open draft 
versions of a document.
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Go To Menu

Non-Component Based Programs

The Go To menu for non-component based programs such as Sales Order Maintenance displays 
the Add Link option. Use Add Link to create links to other programs using User Tool Maintenance 
(36.4.8.5 in EE, 36.20.4 in SE). 

Component-Based Programs

The Go To option for component-based programs displays Go To options and Related Views. 
Related Views are commonly used views and reports that apply to the record you are currently 
working with.

Go To behaves differently depending on whether the current field has data in it:

• If the field has a value, Go To invokes the View activity.

• If the field is blank, Go To invokes the Create activity.

All of the related views take the record you are currently using as the base for the information. You 
can simply click the Go To to see the Create New Budget Group or Create New GL Account Unit 
of Measure. 
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Program Actions Menu

The Actions menu lists active commands that apply to your current program context. 

Non-Component Programs

For non-component based programs, Actions options include navigation commands such as Next, 
Back, Next Record, and Previous Record. These commands let you navigate to the next or 
previous frame, or display the next or previous record for the current field. You can also use the up 
and down arrows on your keyboard to display next and previous records in key fields or when the 
field has been defined to support next/previous processing.

For non-component programs, you can also choose workflow to send a link to the current program 
to a system user (see page 72), e-mail to send a link to an external user, or Export Data, to create an 
XML test file (see page 73). 

Component Programs

The Actions menu functions in a similar way for component-based screens, with some additional 
features. General activities include Undo, Save, Save and Create, Save as Draft (see page 74), and 
Properties. Record-specific activities in the example of the Customer Create program include 
Create, View, Modify, Delete, and Maintain Credit Limit. 
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Workflow

Workflow is available for both types of programs and is visible as an Actions menu option for non-
component based programs and as a Tools menu option for component-based programs. 

Non-Component Based Programs

When you click Workflow in a non-component based program, the system creates a message for 
another system user, with the current screen as an attached link. This message is then posted to the 
user’s Inbox using the .NET UI’s internal messaging system. 

You can also send an e-mail link to non-system users with your PC’s default e-mail system.

Component-Based Programs

Workflow lets you forward final or draft work items to one or more individuals—identified by a 
role—in the organization for completion or validation. You activate workflow using System and 
User Settings. 

You use the Workflow object dialog to specify the name of the workflow, the role of the recipient, 
and activity they are required to perform on the link.
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Record Program Actions

The Export Data function is a test utility in the QAD .NET UI and is available in the Actions menu 
for all non-component based programs. This function lets you record your actions as you complete 
an application process and save the recorded actions to an .XML or .XLS file that you store 
locally. You then execute the saved .XML or .XLS file in the Execute Document Import function 
to reproduce the recorded process on screen. Saved files can be exported for testing to another 
QAD .NET UI environment, or imported into the current environment. 

1 Launch a program.

2 Choose Actions|Export Data. An Export Data screen is displayed (minimized) on the screen 
while the system is recording your user actions. Each user action is immediately listed in the 
Actions grid of this screen, and you can pause, name, and save the recording in this dialog.

3 Enter a variety of actions for the program. These actions are now recorded. The Export Data 
dialog lists the actions, frames, and fields being recorded.
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Saving and Browsing Drafts

The Save as Draft and Browse Drafts options are available for component-based programs only 
and must be enabled by an administrator in Change System Settings (36.24.5.1). When Save as 
Draft is enabled, you can save selected records without completing all the validations required to 
ensure that the record is complete. You can then finish adding data to the record at a later time by 
using the Browse Drafts option to find the incomplete record. 

Only the following subset of components provides the ability to save unfinished records as drafts 
to be completed and approved later. 

• Banking Entry

• Business Relation

• Petty Cash

• Customer

• Customer Invoice

• Finance Charge

• Journal Entry

• Supplier Invoice

• Supplier
  



Programs in the QAD .NET UI 75
Copy

The Copy menu is only available for non-component based programs and lets you to copy the text 
of the current screen to the clipboard, or copy an image of the current screen to the clipboard.
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Print

The Print and Print Preview options are common to both types of programs. Print prints the current 
screen to the default printer and Preview generates a preview of what will print for the current 
screen.
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Attach

Attach lets you attach any type of document—such as a Microsoft Word file, graphics file, or 
PDF—to a record within the application. This integration ensures that all required documentation 
is immediately accessible when needed. You can attach and view any type of file if the 
corresponding viewing software is available on the client. This is applicable to both component 
and non-component based programs.

A copy of the attached document is stored in the system database, which means that the document 
is always available and consistent with the application data. 

Example   Use the Attach option to associate a summary of a customer’s business activities with a 
customer record or attach a PDF of an invoice to a supplier invoice record.

To create a new attachment, click the Attach icon in the toolbar. A standard Windows Open dialog 
displays so you can select the document you want to attach. The number of attached documents 
displays in the menu. To see the attachments, click the chevron in the top bar on the screen. Each 
linked document displays in this view and can be removed if necessary.
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QAD Messaging

QAD Messaging is a messaging and internal e-mail system within QAD applications that lets you 
send messages to other users of the system. When using programs, browses, inquiries, and process 
maps, the QAD Messaging sidebar is permanently available on the left side of the application area 
for sending and receiving messages. You can also use Messaging to process program or browse 
workflow messages, which include links to programs or browses.

To send a message:

1 Click the New icon. 

2 In the To field, enter the user IDs or names of the users to whom you want to send the 
message.

3 In the Subject field, enter text indicating the subject of the message. 

4 In the content area, enter or paste message content. 

5 Click Send to send the message (or click Cancel to cancel it). 
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Summary

Exercise and Knowledge Check

1 Sales Order Control is an example of what type of program?

2 In Sales Order Maintenance, select the Go To function. Add a link to the Sales Order Browse 
program sobr009.p.

Open up a sales order and Go To the Sales Order Browse.

3 Select GL Account List, run the report, and send the output to a printer.

4 Display an existing sales order in Sales Order Maintenance by selecting it from the lookup on 
the Order field. Send the sales order to your user ID by using the workflow. 

a Click Actions and select Workflow. 

b Enter your class login. 

c You should see the message appear in the Messages area of the UI. Open the message and 
see what information is included.

5 Create a document in Microsoft Word. Save it to the c:\ drive and attach the document to a 
purchase order. 
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Chapter Objectives
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Chapter Benefits
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Training Flow
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Introduction to Browse Topics

This chapter covers the following topics:

• Lookup Browses

• Power Browses

• Browse Action Menu, Export to Excel, and Report 

• Browse Setup Menu

• Filters and Operators

• Column Options and Right-Click Column Options

• Grouping and Summarizing

• Component-Based Browses

•  Stored Search and Filter Fields

• Right-Click Options and Excel Integration

• Browses as Favorites

• Quick Search

• Using the Chart Designer

• Operational Metrics
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Lookup Browses

Lookup browses return the value selected to the active field in a calling program. The lookup 
browse has limited functionality. Lookup browses cannot filter, graph, or print data

In the example, when you select the Sold-To lookup in Sales Order Maintenance, you launch a 
lookup browse of Customer master. 
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Power Browses

A power browse can filter, sort, print, and graph data. Columns that cannot be sorted are generally 
non-indexed fields. Sorting by them degrades system performance. Component-based and non-
component based browses share many of the same navigation features:

1 Use the navigation buttons to move through the records. The buttons from left to right move to 
the first set, previous set, next set, last set. 

2 Drag columns by their headings to rearrange the display or click any column heading to sort in 
ascending order; click again to sort in descending order.

3 Blue text indicates a drill-down. Right-click any value to display associated links: either a 
more detailed browse, a related program, or an external Web page. This slide shows the drill-
downs associated with the Order column.

Note   Component browse drill-down applies to the whole record not a field.

4 Use the Records per page drop-down to determine how many records display at one time in 
the browse. The default value can be set using the Rows Per Page setting in Tools|Options. (In 
QAD SE, the Max Browse Records field in User Options Maintenance does not apply to 
browses in the QAD .NET UI.) Some browse options are only available when displaying All. 

Important   Attempting to display a large number of records at once can adversely affect 
performance. Instead, use search conditions to focus on specific records you want to review.

5 Click Clear All to clear browse results.
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Browse Actions Menu

The Actions menu contains export and reporting options, as well as additional workflow and 
e-mail options in non-component browses.

Chart. Select Chart or Grid View to toggle between viewing a chart or the grid view of a 
browse. If a chart has not been created for the browse, the Chart option is not available. Charts 
are set up using the Chart Designer on the Setup menu (see page 114 for details). 

Print. Select to print the current browse. The system displays the standard Windows print 
dialog so that you can select a remote or local printer or print to file. When you print a browse, 
all columns in the browse are printed and scaled to fit the paper size of your printer.

Export to CSV. Exports the contents of the browse to a comma-separated-value (.CSV) file, 
which you can open in spreadsheet applications. The export includes only the columns that are 
marked as visible, so you can exclude columns from the export by hiding them in the grid.

Export to Excel/Export to PDF. Generates an Excel worksheet or a PDF file with the browse 
data.

Workflow. Sends the current browse as link to a selected user using QAD’s internal messaging 
system. When the user double-clicks the link in the e-mail message, the browse is displayed.

Email. Sends this browse as a program link using the client PC’s default e-mail system.

Report. Generates a report of the current browse results.

Auto Go. Automatically refreshes the data in the browse at a user-specified rate.
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Creating Excel Output From Browses

Click the Actions menu and choose Export to Excel.

The export creates three worksheets in an Excel workbook, which is opened for display.

• Data. This page contains the actual data columns and headings from the printed browse.

• Search Conditions.This page displays any search conditions used to filter the printed data. The 
conditions listed are field name, operator, value, and, for a range operation, the ending value.

• Info. This page lists details about the report generation including the ID of the user generating 
the report, the date the report was generated, the name of the browse, and the browse program.

When you export data to Excel, any grouping is retained in the output.
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Browse Report

The slide shows the output of a browse when Report is selected from the Actions menu. The data 
displays in a report viewer and can be printed as needed.
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Browse Setup Menu

The Setup menu lets you access the Chart Designer discussed later (see page 104) and two reset 
options.

• Choose Reset|Sort Columns to change the direction of all column sorts back to initial settings.

• Choose Reset|Reset to Factory Settings to reset all aspects of the browse. Selecting this option 
changes the search criteria, the setting for number of records to view, and all aspects of the 
columns in the browse.

Note   A similar Reset to Factory Setting option displays when you right-click the column 
headings in a browse (see “Right-Click Column Options” on page 94). Choosing this option resets 
only changes made to columns such as size, order, and sort direction.
 



92 Training Guide — QAD .NET UI
Filters and Operators

1 Filtering. If you are using a component browse and stored search criteria exist, you can select 
one by name from the drop-down list at the top of the search criteria. (See page 97 for an 
example.) This sets up the filter criteria to produce preconfigured results. Otherwise (and 
always in a non-component browse), the search fields display with a default configuration.

Note   For non-component browses, you can save a browse configuration to your Favorites 
and use the preconfigured criteria.

Refine the search using combinations of filters and wild cards (* and . for Financials browses). 

2 Search Operators. The various operators include equals, not equals, contains, range, starts at, 
greater then, less than, is null, and is not null. When an equal sign is displayed next to the field, 
you enter an exact matching value. 

3 Search Variable Mode. By default, you specify values for the search, such as Sold-To equals 
C10553. You can also search on logical relationships such as Sold-To equals Ship-To. Click 
the green toggle symbol next to the Search field to toggle between search modes. 

4 To refine your search further, click the plus (+) icon to add another search row. You can add as 
many rows as needed, each with different search values and operators. If you choose the range 
search operator, the second search box is enabled for the ending value of the range. Use the x 
button to remove search filters you no longer want.
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Column Options

1 Change the column order by clicking the column header in the browse screen and dragging it 
to another position in the results list. The double red arrows appear when you can drop the 
heading in a new position.

2 Adjust the column size by clicking on the border of the column header and dragging that 
border to the left or the right.

3 Click the column header to sort all data in the result list on any of the columns. Click the 
header again to sort the data in reverse order. 

4 When you are viewing all records (Records per page is All), each column header also features 
a drop-down filter option. Click the icon to display the available filters. In this example, you 
can filter Item Number by all (the default), blanks, non-blanks, or a specific item number. You 
can also select Custom, which displays a dialog for defining a custom query.
 



94 Training Guide — QAD .NET UI
Right-Click Column Options

Right-click a column heading to display a list of options.

• Use Autosize Columns to resize browse columns based on the size of the displayed data. By 
default, the browse displays with columns already autosized. If you turn this option off and 
manually adjust column sizes, your settings for each browse are retained between sessions. If a 
cell’s data exceeds the column width, three dots (...) are displayed on the right.

• Use the Group By functions to create and manage custom views of the browse data. Group By 
functions are available only when all records are being viewed.

• Use Summary to get a summary of the data in the browse column. 

• Use Hide Column to remove a column from display.

• Use Reset to Factory Settings to return to the default column display settings. The search 
conditions, autosizing, page sizing, and chart definition are all reset.

Note   This Reset is a subset of the reset on the browse Setup menu, which resets all aspects of 
the browse.

• Use Columns to display a list of all columns defined for the browse and toggle the show/hide 
settings. You can use this to restore a column that was previously hidden. This option displays 
the Column Maintenance screen, in which you select the columns to be displayed and the 
position in which they appear on the screen. 

• Use Properties to display technical information about the data in the column. This includes the 
name of the current program and the database table and field where the data for the column is 
stored.
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Grouping Browse Results

This slide shows the result of grouping sales orders by Sold-To Each group can be expanded using 
the plus sign next to it. You can also add other columns to the grid to create a group hierarchy.

Group options are saved automatically in your last used settings, and can be reused when you open 
this browse again. You can also save these options as a stored search.

Add other columns to the grid to create a group hierarchy. Group options are saved automatically 
in your last used settings, and can be reused when you open this browse again. For component-
based browse, you can also save these options as a stored search.
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Summarizing Browse Results

The Summary right-click option lets you display summary information, depending on the column 
header you clicked. The option is context sensitive and displays choices based on the data you are 
viewing. For some columns, you can only summarize by count. But the Quantity Ordered column 
can be summarized by the total sum of ordered amounts, count, average, and the minimum and 
maximum amounts. 

Count. Displays the number of records

Sum. Displays a total sum of the open quantity

Average. Displays the average of open quantity

Minimum. Displays the lowest open quantity 

Maximum. Displays the maximum open quantity 

You must be viewing all the records on the screen to use the Summary option. If there are more 
records than can be displayed, set Records per Page to All.

Note   You only see meaningful results if the operator you choose applies to the data type. For 
example, applying the average operator to a date column does not produce a meaningful result. 

Minimum and maximum are useful with dates, and summary and average with numeric fields.
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Component-Based Browses

Component-based browses are launched when you view, modify, or delete a record created with a 
component-based activity. For example, Supplier Invoice View (28.1.1.3), Supplier Invoice 
Modify (28.1.1.2), and Supplier Invoice Delete (28.1.1.9) all launch browses, in which you select 
the record on which you want to perform the activity.

Component-based browses support some unique features. 

• The way links work is different in these browses. Right-clicking a record lists programs that 
can be used to modify or display information about the record. This linking is maintained 
automatically by the system; you do not need to set up drill-down links in the way they are 
defined for non-component browses. 

• Another special feature is stored searches. The Stored Search menu is shown in this slide. 
Using this menu, you can save a set of search criteria under a name. The stored search is then 
listed for selection when you launch this browse and can be reused. The settings you save 
apply to this browse only and are not listed in browses for other types of records.

Note   With non-component browses you can save a configured browse to your Favorites, 
which saves all your settings, but you cannot save the search criteria and load it directly into 
the browse. 

• Additional options are available when you right-click a browse row. Some component browses 
support an advanced Excel integration.
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Managing Filter Fields

Manage Filter Fields displays all the search fields possible for this type of record. You can use the 
options to:

• Specify whether a filter field should appear on the Selection Criteria tab (Visible column).

• Specify in which order the filter fields should appear. 

• Specify what operator to use when finding data to view.

• Define a persistent initial value or range of values for the filter field. The values for search 
criteria entered in the actual Search Panel are not saved with the stored search. However, the 
initial values entered in Manage Filter Fields are saved. 

• You can refine the default search for GL accounts to retrieve only accounts with codes that are 
within a number range of 1000 to 5000.
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Right-Click Component Browse Options

Component-based browses support additional drill-down and configuration options for individual 
records through the right-click menu. For example, when you right-click a grid line in the Supplier 
View browse, the options shown in this slide display. Most of the options let you navigate from a 
specific record to a related program. You can select a supplier and then see open items for the 
supplier, the supplier’s balance, the supplier’s invoices, and so forth. The exact options vary 
depending on what kind of record you are viewing.

Additional component-based options that are not related to specific records are:

Excel Integration. This option lets you export data into Excel spreadsheets, create new data 
within Excel, and import it to the system database, where it is validated before being saved.

Note   This advanced bi-directional Excel integration is supported in only a subset of 
components.

Dump XML. Select to export selected lines to an XML file for analysis. You are prompted to 
specify a name for the output file and a format. This option is described in more detail in User 
Guide: QAD System Administration.

Force Publish. This option is used with event publishing that lets changes to master data be 
published and synchronized with other external systems and is described in more detail in 
User Guide: QAD System Administration.
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Excel Integration

Using Excel Integration has multiple steps. This example uses supplier records.

1 Right click in a Supplier browse and choose Excel Integration. An empty grid displays.

2 Right-click in the empty grid and choose Load Suppliers. The Load option lets you retrieve all 
database records for a supported business component.

3 When the load completes, right-click in the grid and select Export to Excel for Maintenance. 

4 Save the Excel file in a folder that can be accessed so that the Excel sheet can be modified. 
Make the required changes to the Excel file and save it.

5 Return to the supplier browse, right-click grid and select Import from Excel. Click Save to 
create or update the data in the system database.

The changes you made should now be reflected in the database records. 

Note   With Excel Integration, you can also import from Excel to create new records without 
exporting first. 
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Browses as Favorites

Non-component browses do not support the Saved Search feature, but you can save both types of 
browses to your favorites:

1 Click the Add to Favorites button. 

2 The browse is saved to your Favorites area and named based on the name of the browse. 

If it is the first instance you have saved, the browse name in the Favorites area is the name of 
the browse. If you save the same browse again, a (2) is appended to the name in the Favorites 
area.

3 Once you have saved the browse to the Favorites pane, you can rename the browse and 
organize it in the same way as other items saved in the Favorites pane.
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Renaming Browse Favorites

To rename a browse:

1 Right-click the browse.

2 Click on Rename.

3 Enter a new name for the browse.
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Quick Search

The Quick Search filter (*Search For) is available in all power browses and lets you search for a 
value across all of the fields in the browse. Quick Search looks for integers and text strings only 
and does not retrieve dates.

Use the *Search For option from the Search pull-down list in a browse to retrieve all the results 
that contain the search value in any of the columns. Choose the Contains, Starts With, or Equals 
operator for the system to use when searching across columns in the browse data. 

You can also create groups of browses for quick search purposes by adding them to the Quick 
Search panel. By default, the browse groups area of the panel is empty. Create a new browse group 
by right-clicking on the panel and selecting New to create a new browse folder. Add individual 
browses or browse collections by selecting the folder and dragging and dropping browses from the 
Applications panel. 

After you have created the browse groups, select one and enter a search term in the Quick Search 
field. Press Enter to search the browses contained in the folder for the term. The results display in 
browse format in the workspace. 
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Using the Chart Designer

With the Browse Chart Designer, you can:

• Quickly generate graphical representations of browse data.

• Toggle between the standard browse display (called the grid view) and the chart view.

• Use the chart view editor to select data in a browse and display the data in graphical format, 
such as a pie chart or bar graph.
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Creating Charts from Browses

The Browse Chart Designer lets you choose settings that define a chart: 

X-Axis and Y-Axis Label. Enter the label for the chart’s x and y axis data.

X-Variable. Select the variable for the x-axis data from a pull-down menu listing the available 
columns in the browse.

Y-Variables. Select up to five variables for the y-axis data from a pull-down menu listing the 
available columns in the browse. 

Group By X Values. Select Yes if you want to display all the common x-axis data together in 
groups. Select No if you want to display the x-axis data individually. 

Chart Title. Enter a title for the chart.

Chart Type. Select from among the available chart types.

Preview. Click the Preview Chart button to view the chart before you save it.

You can toggle between the chart view and the grid view of the browse by selecting Chart or Grid 
View on the Actions menu. If you are in chart view, Grid View is displayed on the menu, and if 
you are in grid view, Chart is displayed.
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Chart Options 

While in chart view, you can do the following:

Rotate and Zoom 3D Charts. You can rotate 3D charts by pressing the Alt key and moving the 
mouse. Similarly, you can zoom 3D charts by pressing the Alt key and moving the mouse’s 
scroll wheel. 

Search Charts. The QAD .NET UI’s browse search capabilities apply to the chart view as well 
as the grid view. By using the search capabilities you can interactively change the chart view 
of the browse. 

Hide Titles and Legend. Chart titles and legend are shown by default. You can hide (or show) 
titles by right-clicking and selecting Hide Titles (or Show Titles). Similarly, you can hide (or 
show) the legend by right-clicking and selecting Hide Legend (or Show Legend). 

Launch in New Window. To launch a chart in a new window, right-click the chart and select 
Launch in New Window. 

Copy to Clipboard. You can copy the chart to the clipboard so you can paste it in other 
applications. To copy the chart to the clipboard, right-click in the chart area and select Copy to 
Clipboard. 

Edit Chart Design. To return to the chart editor, select Chart Designer from the Setup menu.
  



Browses in the QAD .NET UI 107
Interactive Charting

For any item in the chart that has a drill-down, you can have a split-screen view of both the chart 
and the drill-down browse, which can also be displayed as a chart. 

• When you click on an item in the first chart, the drill-down chart will automatically change to 
reflect the changed data for the drill-down. 

• Clicking on an item in the chart also selects the associated row in the browse.

• Conversely, clicking on a row in a browse also selects the associated item in the chart.
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Operational Metrics

The Operational Metrics option lets you create a graphical metric from browse data. Operational 
metrics provide a live snapshot of production data, which lets you monitor in real time how the 
system is being used. You can use operational metrics to visually track any type of browse data, 
including data from customized browses created in Browse Maintenance. 

A number of predefined metrics are supplied with the system in the Metrics folder. In this slide, the 
Accounts Receivable metric displays different customer metric results. 

Metrics are created and managed by administrators using the Create Metric Collections function 
on the Administration menu. 
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Creating Metric Collections

1 Select Create Metric Collection from the Administration menu to create the initial metric 
collection. The system prompts you to name the collection.
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Creating Metric Groups

2 Right-click the collection title, or select Edit|Create Metric Group to create a metric group for 
the collection. 

3 A list of browses in the system displays so you can select the parent browse for the group. 
Double-click the name of the browse to select it.

4 You are prompted to name the Metric Group. Enter a name for the metric group (for example, 
Customers by Site) and click OK. The system then prompts you to create the first metric.
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Creating Operational Metrics

Title. Enter a title for the metric (for example, Customers at site 10-100).

Type. The default type is Count. When you select the Count type, the browse filter drop-down 
is unavailable. Type options depend on the type of browse. For browses that produce 
numerical values as results, you can also choose Sum, Average, Maximum, or Minimum as the 
Type option. When you select a type other than Count, you can then select the value to which 
you apply the type. 

Percent/Range. Select Percent to display the metric as a percentage of the browse total.Select 
Range to display the metric as a range of figures. This option lets you increase the granularity 
of the results. 

Search. Select the browse filter, operator, and value to define the metric. For example, this 
metric is based on the number of customers in Customer browse whose site code equals 
10000. You therefore select the site code filter to equal 10000. You can set multiple filters for 
the metric, as you do on a normal browse. Click Search to find out how many sites meet the 
criteria (in this case, the number is 33). This information is displayed as a percentage of the 
total (when you have selected the Percent display option). Use the slider controls on the 
percentage bar to set the color code for thresholds.
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Editing Operational Metrics

You can edit metric details by right-clicking the metric name on the main screen and selecting 
Edit. Click on the Save button to save the operational metric to the Metrics folder, New to save the 
metric for the first time, and Replace to replace an existing metric.

The metric is now available in the Metrics folder. You can add operational metrics to Favorites. To 
refresh the metric information, rerun the individual browses from within their metrics.
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Summary
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Exercise and Knowledge Check

1 Open up the Sales Order Browse. Highlight any Sales Order and drill down by double-clicking 
a Sales Order number. In the Sales Order Maintenance screen that appears, click the Sold-To 
lookup.

2 Go to Supplier Invoice View and display a component-based browse.

3 Use Sales Order Browse and limit the output of the Sales Order Browse to orders for one 
specific customer.

What filter did you use? What operator did you use? Send the output to an Excel sheet.

4 From the Metrics folder, display the Accounts Receivable metric. 

5 Run Excel Integration for Country Browse. Delete a country and re-import the Excel sheet.

6 Run Sales Order Browse and rearrange the columns. Group the results by Sold-To.

7 Use Chart Designer to create a chart for Item Master Browse. 

Label the x axis Product Line and select the variable prod line.

Label the y axis label Part Number and select the variable item number and group by count.

Select a 3D pie chart and run the chart. 
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Chapter 6

Using the Character UI
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Chapter Objectives
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Training Flow
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Character UI Login Screen

To start a character session, follow the procedures provided by your system administrator. The first 
screen you see after launching the system lets you log in to the system. Enter the login ID assigned 
by your system administrator and your password. If you have been given access to more than one 
domain in the system, enter its name in the Domain field. If you have access to only one domain, 
this domain displays in read-only mode. You must be a valid user to log in. Your password can be 
blank only if the password in your user record is blank.
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Main Menu

QAD Enterprise Applications has locations for 36 modules on the character-based main menu. In 
turn, each module has one or more menus attached to it. Menus are lists of programs you use to 
look up or input data.

The menus that you see depend on the security access that has been granted to your role. Only 
menus with programs that you have access to display. When you enter a menu number on the 
command line, the system either executes a program or displays a lower-level menu. You can keep 
drilling down through the menus until you reach the appropriate level. Alternatively, you can 
access a program directly by entering its Progress name—such as ppptmt.p for Item Master 
Maintenance—or number at the command prompt.

If the current menu displayed is System Admin (36), you can enter 2.13 to access Generalized 
Codes Maintenance. However, you must enter .1.4.1 to run Item Master Maintenance (1.4.1) 
because it is on a different submenu.

You can also use the arrow keys to move around the menu, then press Enter to execute the 
highlighted selection.
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Menu Substitution

Menu substitution lets you toggle between displaying browses and inquiries on the menu. You can 
also use it to switch between customized and non-customized versions of a program. The system 
administrator can use Menu Substitution Maintenance (36.4.4.7 in EE, 36.20.6 in SE) to specify 
which programs are substituted for others when you select this option. By default menu 
substitution is disabled. It can be enabled for individual users in User Maintenance (36.3.1).
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Program Screen Elements

The title bar identifies the program currently running. What displays in the title bar depends on the 
Header Display Mode setting in Security Control (36.3.24). Based on that setting, you may see any 
of the following elements:

• The title bar includes—from left to right—the program name, the version of the program, the 
menu number and title, and the current date.

• The title bar is the same as previous except that the login ID of the current user replaces the 
current date.

• The title bar includes—from left to right—the short name and currency of the current working 
domain, the menu number and title, and the current date.

• The title bar is the same as previous except that the login ID of the current user replaces the 
current date.

Program Window

• The program window displays the frames and fields of the current program.

Progress Status Bar

• The status bar shows the basic commands needed to navigate through the specific program 
currently displayed in the program window. 
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Character UI Browse 

Browses display selected data in the form of a table. Browses in the character UI are similar to 
those in the .NET UI, but have a simpler set of features. Two types of browses are available:

• Lookup browses return the value you select to the active field in the calling program.

• Drill-down browses display, filter, or print data.
  



Using the Character UI 125
Browse Menu Bar

To scroll through the records, use the Up and Down arrows.

The User Menu in the browse menu bar differs from the User Menu accessed by pressing F6. The 
User Menu in the browse menu bar provides access to:

• Print Options

• Run Program

• Exit

Edit

Cutting text deletes it from its current location and copies it to the clipboard. Copying is similar, 
but it leaves the original text in place. In both cases, you can paste the text to another location, such 
as a field.

1 Choose the text to cut or copy.

2 Display the Edit Menu. This menu choice is available only when text is selected.

3 Choose Cut or Copy.

4 Position the cursor in the new location.

5 Choose paste.
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Options

• Browse Options. Use this option to set up filter criteria for browses. The filter criteria limit the 
viewable records according to your specifications. For example, you can filter out product 
numbers or statuses that you do not want to view.

• Toggle Filter: Use the toggle filter setting to turn on and off the filter criteria set up in the 
browse filter options.

Help

Use this menu to access help on fields, as well as display drill downs and lookup browses on 
selected fields. The fastest way to get help for the current field is by pressing F2 twice: press F2 
once and, if available, a lookup browse displays) but you can also bring it up with the Help menu. 
With the cursor in the field, drop down the Help menu and choose Field Help and procedure help.

Output Devices

You can send the output from reports, inquiries, and browses to a number of devices, including the 
following:

• Your terminal

• A server printer

• An e-mail message

However, the character user interface does not offer as many options as the QAD .NET UI. You 
can send output to Terminal or page, but not to Window. If you select Window, the system displays 
an error message. The Winprint option is designed only for Windows clients. If you select this 
option, the system displays an error message. Otherwise, the output options are the same in both 
interfaces. If you select a printer as the output device, be sure to use one that has been defined with 
a destination type of Default in Printer Setup Maintenance (36.13.2). Just as in the QAD .NET UI, 
you cannot use e-mail unless it has been set up properly.
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Summary

Exercise

Is the .NET UI or the character version a better option for your company? Why Or why not?

Go to the sold-to field in Sales Order Maintenance and pull up the drill-down browse, field help, 
and procedure help. What key or keys did you use?
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